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Abstract

Renal hypoxia is generally accepted as a key pathophysiologic event in acute kidney injury of various origins
and has also been suggested to play a role in the development of chronic kidney disease. Here we describe
step-by-step data analysis protocols for MRI monitoring of renal oxygenation in rodents via the deoxyhe-
moglobin concentration sensitive MR parameters T2* and T2—a contrast mechanism known as the blood
oxygenation level dependent (BOLD) effect.
This chapter describes how to use the analysis tools provided by vendors of animal and clinical MR

systems, as well as how to develop an analysis software. Aspects covered are: data quality checks, data
exclusion, model fitting, fitting algorithm, starting values, effects of multiecho imaging, and result
validation.
This chapter is based upon work from the PARENCHIMA COST Action, a community-driven network

funded by the European Cooperation in Science and Technology (COST) program of the European
Union, which aims to improve the reproducibility and standardization of renal MRI biomarkers. This
experimental protocol chapter is complemented by two separate chapters describing the basic concept and
data analysis.
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1 Introduction

The parametricmapping of the transverse relaxation timesT2* andT2

(or relaxation ratesR2*¼ 1/T2* andR2¼ 1/T2) has the potential to
yield inferences regarding renal oxygenation, since both parameters
are sensitive to blood oxygenation [1]. The underlying mechanism
rests on the inherent difference in the magnetic properties of oxyge-
nated hemoglobin (diamagnetic) vs. deoxygenated hemoglobin
(paramagnetic) [2]. The presence of deoxyhemoglobin in a voxel
decreases both relaxation times, T2* and T2, which are the time
constants governing the exponential signal decays due to spin
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dephasing in gradient-echo (GRE) and spin-echo (SE)MRmeasure-
ments, respectively.

Possible sources for this dephasing are magnetic field inhomo-
geneities ranging from the microscopic to the macroscopic scale,
which can be classified with respect to the echo time into micro-
scopic dynamic spin–spin interactions—T2, that is, typically ranging
a time span between 1 and 100 ms (Fig. 1) and static mesoscopic
interactions—T2

0. In fact, T2* includes the dynamic (irreversible)
dephasing effects described by T2 plus the additional effects that are
due to static (reversible) dephasing effects described by T2

0. Blood
oxygenation affects primarily T2* (often referred to as Blood Oxy-
genation Level Dependent, BOLD), but to a lesser extend also T2,
via water diffusion effects in the proximity of blood vessels due to
local magnetic field gradients [1].

Calculation of T2* and T2 requires a series of MR images with
different echo times. Repeated measurements with a single echo

Fig. 1 Spin dephasing due to dynamic (irreversible; represented by the parameter T2) and static (reversible;
represented by the parameter T2

0) sources can be quantified by calculation of T2* and T2 from series of MRI
images with different echo times using 1/T2* ¼ 1/T2 + 1/T2

0. The possible sources for this dephasing range
from the microscopic to the macroscopic scale and their level dictates the observed attenuation in the signal
intensity. Blood oxygenation affects primarily T2* (often referred to as Blood Oxygenation Level Dependent,
BOLD), but to a lesser extend also T2 via diffusion effects in the proximity of blood vessels. USPIO: Ultra-small
Superparamagnetic Particles of Iron Oxide, which can be used as intravascular contrast agents
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sequence using either a GRE or SE method and variable echo times
(TE) would provide the most accurate T2* and T2 values but would
require very long acquisition times [2]. In order to address this
shortcoming fast multiecho MRI methods are commonly used for
in vivo studies: multi-gradient-echo (MGE) for T2* andmulti-spin-
echo (also called “MSME”) for T2. They provide relaxation times
that slightly underestimate T2* and overestimate T2 (see Note 1).

The core of T2
(*) mapping consists of fitting the exponential

model curve S(TE) ¼ S0 exp.(�TE/T2
(*)) to the signal intensities

of each image pixel at increasing TE. For the calculation of such
parameter maps from a series of T2

(*)-weighted images software
tools and plugins are provided by the MR system vendors but they
may lack some features instrumental for precise T2

(*) mapping. For
example, some important preprocessing steps may not be available,
such as eliminating the first echo of T2 data, removing echoes
acquired at high TEs that may have too low signal-to-noise ratio
(SNR) or applying Rician noise bias correction. Also, details about
the used processing and curve fitting algorithms may not be avail-
able. It is also a limitation that the algorithms are fixed and cannot
be modified for specific purposes. Therefore, depending on appli-
cation, it may be advantageous to develop a dedicated analysis
software program in-house. The analysis software is developed
assuming 2D data was acquired, for 3D data (multiple slices) data
set are separated into individual slices.

The pixel-wise signal fitting with a monoexponential model is
known to introduce T2 bias, and so for studies that require an
extremely rigorous T2 value (error < 1%) a dictionary-based
method has been suggested. In dictionary-matching methodolo-
gies, T2 maps are calculated by matching the T2 signal decay to
precomputed Echo Modulation Curve (EMC), therefore account-
ing for all echo pathways. The use of dictionary-based methods has
been suggested to improve T2 accuracy, accounting for the stimu-
lated echoes and effective B1

+ field [3]. The use of dictionary-based
methods is still fairly novel and its implementation and use is not
covered in this chapter.

This chapter will describe both how to use the vendor’s analysis
tools and how to develop your own analysis software conceptually.
An example of a MATLAB script described in this chapter together
with a data sample (T2analysis.m and data.mat) can be down-
loaded from https://github.com/JoaoPeriquito/T2-s-Mapping.

This data analysis protocol is complemented by two separate
chapters describing the basic concept and experimental, which are
part of this book.

This chapter is part of the book Pohlmann A, Niendorf T (eds)
(2020) Preclinical MRI of the Kidney—Methods and Protocols.
Springer, New York.
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2 Materials

2.1 Software

Requirements

2.1.1 Essential Tools

To calculate the parametric maps using existing tools, a software
such as the following is required:

1. MR system software ParaVision (version 5 or higher; Bruker
Biospin, Ettlingen, Germany).

2. MR system software Syngo (versions MR B17 or higher; Sie-
mens Healthineers, Erlangen, Germany). The optional toolbox
MapIt is not necessary.

3. MR system software Ready View (General Electric Healthcare,
Milwaukee, USA).

4. MR system software from Philips (Philips Medical Systems,
Best, Netherlands).

To develop custom software for calculating the parametric
maps one of the following, or other equivalent, software develop-
ment environments (SDE) is required:

5. MATLAB® including the Curve Fitting toolbox (The Math-
Works, Natick, Massachusetts, USA; www.mathworks.com/
products/MATLAB).

6. Python (https://www.python.org/).

7. Octave (http://www.gnu.org/software/octave).

8. A MATLAB tool for Rician noise bias correction can be down-
loaded from https://github.com/LudgerS/
MRInoiseBiasCorrection. It is also compatible with Octave
and includes detailed documentation to facilitate adaptation
for, for example, Python.

2.1.2 Optional Tools An image processing software for checking data quality, such as
ImageJ (free Java-based image processing program developed at
the National Institutes of Health and the University of Wisconsin;
https://imagej.net/). We recommend and describe here the use of
Fiji (https://fiji.sc/ [4]), which is ImageJ packaged with a wide
range of plugins included.

2.2 Source Data:

Format Requirements

and Quality Check

Before the analysis it is highly recommended to check the image
quality. This check should include SNR measurements, particularly
for the images with longest echo times, and the assessment of
geometric image distortions, motion artifacts, or susceptibility
artifacts.

The steps in this section can be performed either on the scanner
console using the MR vendors system viewing software, or offline
using a software such as Fiji (recommended as a practical tool).

594 João S. Periquito et al.

http://www.mathworks.com/products/MATLAB
http://www.mathworks.com/products/MATLAB
https://www.python.org/
http://www.gnu.org/software/octave
https://github.com/LudgerS/MRInoiseBiasCorrection
https://github.com/LudgerS/MRInoiseBiasCorrection
https://imagej.net/
https://fiji.sc/


2.2.1 Input Requirements As already mentioned, in order to be able to calculate T2
(*)-maps,

multiple images acquired with different echo times are needed. As
an example, please refer to Fig. 2 and Fig. 3, where a series of T2*-
and T2-weighted images suitable for mapping is presented (see
Note 2). Access to specific acquisition parameters is also necessary,
namely the TE of each image and in some cases the image intensity
scaling parameters (offset, slope) used when storing the image data.

2.2.2 Open/Import

Images

When using the scanner console:

1. Open the T2
(*)-weighted image series in the image viewer.

When using Fiji for DICOM images:

2. Import the DICOM image series using the DICOM import
plugin.

When using Fiji for images in Bruker format:

Fig. 2 Series of nine T2*-weighted images of a healthy rat kidney acquired with a 2D MGE sequence at 9.4 T.
From left to right and top to bottom, images correspond to TE ¼ 2.14, 4.28, 6.42 ms (top row), TE ¼ 8.56,
10.70, 12.84 ms (middle row), and TE ¼ 14.98, 17.12, 19.26 ms (bottom row)
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3. Browse to the data directory for the scan containing the T2
(*)-

weighted image series: /opt/PV6.0.1/data/[user_name]/
[session_name]/[scan_number]/.

4. Open the “method” file of the scan in a text editor or by
dragging it to the Fiji window.

5. Get the following parameters: number of slices, matrix size
(e.g., 128 � 128) image type (e.g., little-endian) and byte
order (e.g., 16-bit unsigned).

6. Load the image series using the RAW import function
(Import > RAW) and providing the above parameters. The
MR data file is called 2dseq and located in the subfolder
“pdata/nr” (number of reconstruction) of the data directory.

2.2.3 Motion

Artifacts Check

Abdominal imaging comes with complex bulk physiological
motion due to the interplay of respiratory and bowel movement.
If respiratory triggering of the data acquisition was used (recom-
mended) there should only be minor motion artifacts. Check

Fig. 3 Series of seven T2-weighted images of a healthy rat kidney acquired with a 2D MSME sequence at
9.4 T. Images correspond to TE ¼ 10.0, 20.0, 30.0 ms (top row), TE ¼ 40.0, 50.0, 60.0 ms (middle row), and
TE ¼ 70.0 ms (bottom row)
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images for artifacts from motion (nontriggered acquisition) or
possible residual motion (triggered acquisition).

In the image viewer or Fiji go to the central slice and scroll
rapidly from the first to the last echo image.

1. Check for motion between the echoes. If motion is noticeable
then information close to structure boundaries may not be
reliable and image registration should be used for motion
correction (registration is a separate topic that is not explained
in this chapter).

2.2.4 Susceptibility

Artifacts Check

on T2*-Weighted Images

Kidney regions adjacent to bowels or in close proximity to skin/
fat/muscle boundaries or air cavities are particularly challenging to
T2* imaging and prone to loss of anatomical integrity due to
geometric distortions and signal loss created by susceptibility arti-
facts induced by the air-filled bowels, cavities and tissue interfaces
surrounding the kidneys.

1. Scroll to the images acquired at the later echoes, where suscep-
tibility artifacts are more severe.

2. Check areas affected by susceptibility artifacts, that is, areas in
the kidney with unusual and severe hypointensities (typically in
the form of spherical dark “shadows”; Fig. 4).

3. Make a record of areas affected by such artifacts (notes, screen-
shots). They must be excluded from the analysis or at least be
considered during interpretation of the result.

2.2.5 Signal-to-Noise

Ratio Check

Before the analysis it is highly recommended to define an SNR
acceptance threshold (see Note 3).

1. Draw a region-of-interest (ROI) over the inner medulla in the
first echo image (in Fiji use the “Freehand Selection” tool) (see
Note 4).

Fig. 4 T2*-weighted image of a rat kidney that shows a susceptibility artifact at
the caudal end (white arrow); image acquired with TE¼ 10.70 ms at B0 ¼ 9.4 T
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2. Measure the mean signal intensity of the ROI (in Fiji: Ana-
lyze > Set Measurements; select mean and standard deviation;
Analyze > Measure).

3. Draw an ROI over a region in the background that contains
only noise without any signal or artifacts (see Note 5).

4. Measure the standard deviation of the signal within this back-
ground ROI.

5. Divide this value by 0.655 to obtain the noise standard devia-
tion. This is necessary because the background noise in MR
magnitude images differs from noise in signal regions (seeNote
6 if you use a multichannel RF array).

6. Calculate the SNR by dividing the mean signal of the inner
medulla ROI by the noise standard deviation.

7. If the SNR is significantly below your predefined acceptance
threshold, this indicates that there might be a technical prob-
lem or that the animal is not positioned correctly relative to the
receiver RF coils. For more information on adequate SNR
thresholds refer to Note 7.

3 Methods

Tools for calculating T2
(*)-maps are provided by most MRI ven-

dors, but, as mentioned in the introduction, we recommend creat-
ing your own analysis tool to have the maximum level of control
over the processing steps and freedom to adapt them to your
specific needs. Hence, this section will describe both how to use
vendor’s analysis tools and how to develop your own analysis
software.

In both cases, mapping of T2 and T2*, it may be required to
exclude some data from the analysis, such as data points with
insufficient SNR in the tail of the exponential decay. In the case of
T2-mapping from data acquired with a MSME method, it is also
recommended to discard the first echo (see Note 8).

3.1 Data Exclusion

and Model Fitting

(Siemens Syngo)

When using the Siemens scanner console this is currently not
possible, but one can manually select the echo images that should
be included when computing the fit. Using this feature, one can
exclude entire images at high TEs. We recommend using a cut-off
for echo images with low SNR. Please exclude all echo images with
SNR < 2.6 in the ROI of interest (see Note 7). When performing
T2-mapping, the first echo should also be excluded from the data
analysis (see Note 8).

1. Load image series in the Viewing Task Card.

2. Using the ROI tool to draw an ROI on the image with the
largest TE over the region of interest, and register the mean
signal.
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3. On the same image, use the ROI tool draw an ROI on the
background, and register the standard deviation of the signal.
Divide this value by 0.655 to obtain the noise standard devia-
tion (see Note 6 if you use a multichannel RF array).

4. Calculate the SNR by dividing the mean signal ROI by the
noise standard deviation. If the SNR is below 2.6 this image
should be excluded on step “8” (see Note 7).

5. Select a 3 � 3 or 4 � 4 layout in the View tab of the Control
Area (right panel) in order to see all acquired echo images.

6. Select all echo images for T2*-mapping or all echo images
except the first for T2-mapping (Fig. 5).

7. In the Control Area choose Eval > T2 > OK. Two new images
will appear in the viewer, the T2

(*)-map and the S0-map.

8. Exclude all echo images that have a SNR < 2.6 (see Note 7).

Fig. 5 Selection of echo images for T2
(*)-mapping of a rat kidney in Siemens Syngo. Here T2-mapping was

performed, for which the first echo image must be excluded. Then start the T2
(*)-map calculation with the T2

button in the Eval tab in the Control Area panel on the bottom right
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9. In the Control Area choose Eval > T2 > OK. A T2
(*)-map will

appear in the viewer. Use this new map for further analysis/
quantification (Fig. 6).

3.2 Model Fitting

(General Electric T2
(*)

Map Ready View)

On a GE system a similar tool is used for mapping of T2 and T2*.
The Ready View T2 Map protocol post processes data sets acquired
using the Cartigram (T2 Map) application. The T2 Map layout is
comprised of four viewports: upper-left Map viewport: source
image, upper-right viewport: curve displaying signal intensity (ver-
tical axis) and the echo number (horizontal axis). A data point for
each echo is plotted when an ROI is deposited on any of the three
images. Lower left viewport: T2 Map Preset-1 parametric image.
Lower right viewport: T2 Map Preset-2 parametric map.

Use these steps to post-process data sets acquired using the
Cartigram application. The T2

(*) relaxation time color map is

Fig. 6 T2-map of a rat kidney calculated using the T2-analysis tool of Siemens Syngo from data acquired with
a clinical 3 T scanner
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coded to capture T2
(*) values from the TE range of the acquired

images. Blue and green reflect the longer T2
(*) values, yellow the

intermediate T2
(*) values, and red and orange the shorter T2

(*)

values. The functional T2
(*) map units are ms.

1. Open ReadyView and start the T2map protocol.

2. Adjust theW/L (window width and level) and magnification—
to adjust the W/L, middle-click and drag over the image. To
adjust the magnification factor, place the cursor over the red
DFOV and middle-click and drag right to left.

3. Locate the desired images to view—press the Up and Down
arrows to move through the images to locate the image with
the area of interest. Or click and drag the red slice Location
annotation. Press the Right and Left arrows to select the
desired echo or click and drag the red echo annotation.

4. Open the T2 Map Settings screen.

5. Adjust the settings on the T2Map Settings screen. Typically, the
Preset Color Level sliders for both the T2

(*) map and para-
metric image are within a 10 and 90 ms range and the Thresh-
old is 20. Typically, the Confidence Level is 0.05. A default
smoothing kernel of 2 is recommended.

6. Click Compute.

7. If necessary, use the Clip Min & Max values. By default
(25–75).

8. In the measurements panel, select the ROI icon and draw the
desired region of interest. An annotation with the area, mean
value and standard deviation of the ROI will appear.

3.3 Model Fitting

(Philips)

1. When acquiring a T2
(*) (mTSE/MGE) dataset, select the Post-

proc tab and choose the option T2(*) or R2(*) (1/T2
(*)) under

the field Calculated images (Fig. 7).

2. Insert the maximum expected T2
(*) or its reciprocal (1/T2

(*))
under the field T2 clip value or its reciprocal R2(*) clip value to
specify the maximum calculated T2

(*)/R2
(*) value for the SE

sequence. Larger T2
(*)/R2

(*) values are clipped to this value.

3. By default, T2/T2* reconstruction includes the first echo and
performs a MLE fitting of the signal curve. Research customers
can modify these parameters under the Scan Control Para-
meters panel select Reconstruction and choose the option
Include first echo for (SE) T2,R2 calc (yes/no), and reconstruc-
tion method (MLE [5, 6] or Least squares (RLSQ)) for T2

(*),
R2

(*). If available we recommend to use Include first echo ¼ no
and the default MLE calculation method (see Note 9)—Warn-
ing: changing these options affects every scan until reset of the
system (Fig. 8). After the acquisition, drag and drop the images
in the viewer.
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3.4 Data Preparation

and Model Fitting

(Custom Program)

The following custom program for T2
(*) relaxometry contains code

examples following MATLAB syntax. These were tested to be
compatible with Octave and should be easily reproducible in
Python or an equivalent SDE.

3.4.1 Data Import

and Exclusion of First TE

(Only for T2)

1. Import your scan with the images obtained for different TEs.
Bruker data: inMATLAB use the import function provided

by Bruker’s pvtools—to obtain Bruker’s pvtools send an e-mail
to Bruker mri-software-support@bruker.com.

DICOM data: in MATLAB use the dicomread function—
https://mathworks.com/help/images/ref/dicomread.html;
in Python use dcmread from the pydicom package—https://
pydicom.github.io/). As input you need to provide a string
containing the full path of the DICOM file.

Fig. 8 Philips acquisition software Scan Control Parameters panel—only accessible for research customers.
Here under the Reconstruction tab select no on the option Include first echo for (SE) T2/R2 calc. to exclude the
first echo image on T2 mapping and select MLE for T2(*), R2(*) calculation method (see Note 9)

Fig. 7 Philips acquisition software Postproc tab. Here T2-mapping can be performed by choosing the option T2
or R2 (1/T2) under the field Calculated images
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2. As previously explained, when performing T2-mapping using a
multiecho sequence, the first echo must be excluded from data
analysis (see Note 8). For example, that could mean that for a
series of T2 weighted data acquired at TE ¼ 10.0, 20.0, 30.0,
40.0, 50.0, 60.0, 70.0 ms one would only be able to fit the
model curve to the TE ¼ 20.0, 30.0, 40.0, 50.0, 60.0 ms data
points: store your data in a different variable excluding the first
TE (imgData_forAnalysis ¼ imgDataT2w(:,:,2:end);
TE_forAnalysis ¼ TE(2:end)).

3.4.2 Rician Noise Bias

Correction

MR signal intensities are overestimated in low SNR magnitude
images. This bias is due to the Rician distribution of noisy MR
magnitude data and can be corrected in post-processing. We can
understand the processing step as multiplication with a signal-level
dependent correction factor, which approaches 1 as higher SNRs
are reached. To incorporate Rician noise bias correction into our
custom program, we first need to determine the noise level and
then utilize a MATLAB/Octave tool provided for this book under
https://github.com/LudgerS/MRInoiseBiasCorrection:

1. Add the downloaded noise correction tool to the search path.

Addpath(genpath(‘. . .\MRInoiseBiasCOrrection)).

2. Compute unbiased data by executing the following:

imgData_corrected¼correctNoiseBias(imgData_forA-
nalysis,sigma,1)

If you work with data from amultichannel RF array, change
the last argument of the function to the number of receive
elements.

3.4.3 Fitting Model The most common method is to iteratively fit the model of the
T2

(*) decay to the signal intensity (SI) data of each pixel using the
following equation:

S TEð Þ ¼ S0: exp � TE

T
∗ð Þ
2

 !
ð1Þ

where S0 is a scaling factor that includes many parameters such as
the proton density together with the signal gain of the system.

3.4.4 Starting Values An important step of the curve fitting process is the choice of
suitable starting values for each parameter that will be determined
by the fitting algorithm (NB: different starting values may lead to
different results!). Here we describe how to derive starting values
from the SI of each pixel.

1. Step through all pixels in the images using for loops for the
pixel coordinates x and y.
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2. Store the SI of that pixel at all TEs in a vector (in MATLAB:
SI_vector ¼ imgData_forFitting(xPix, yPix,:)).

3. As starting value for the parameter S0 use the first and largest SI
(startVal_S0 ¼ SI_vector(1)).

For estimating a starting value for T2
(*), one can exploit the fact

that at TE ¼ T2
(*) the SI has fallen to 37% of its value at TE ¼ 0.

Estimate the starting value by determining the TE whose SI is
closest to 37% of the largest SI value:

4. Normalize the SI vector to a maximum value of 1 (divide by the
largest SI value).

5. Subtract 0.63 from the SI vector.

6. Get the absolute values of the SI vector (resulting in only
positive values).

7. Find the index of the smallest value in the vector (in MATLAB:
[min_Value,min_Index] ¼ min(SI_norm_abs_37pct)).

8. Get the respective echo from your echoes using the index from
the last step (startVal_T2¼TE_forFitting(min_Index)).

3.4.5 Fitting Algorithm Least squares algorithms, such as the Levenberg–Marquardt [7]
and Trust-region methods [8], are the most commonly used curve
fitting algorithms for T2

(*)-mapping. They work by minimizing a
cost function, which describes the deviation of the fitted curve from
the corresponding data points. With starting values near the opti-
mal solution they quickly converge, but with starting values far
away from the solution, the Levenberg–Marquardt algorithm will
slow down significantly. Also, there is the risk that it may converge
to a local minimum (rather than the global minimum) and hence
produce an erroneous result.

In contrast, the Trust-region method (a further development
of the Levenberg–Marquardt algorithm) will quickly converge,
even with suboptimal starting values, and it will always find the
global minimum. However, it does require the definition of lower
and upper limits for the parameters to be fitted. Hence, for T2

(*)-
mapping, where such limits can easily be defined, the Trust-region
method is well suited (see Note 10)

1. Create for loops for pixel coordinates x and y to step through all
pixels of the image.

2. Store the SI of that pixel at all TEs in a vector (in MATLAB:
SI_vector ¼ imgData_forFitting(xPix, yPix,:)).

3. Define the model for the function using Equation1
(in MATLAB: T2model ¼ fittype(‘a*exp.(�x*b)’,
‘independent’, ‘x’, ‘dependent’, ‘y’)) .
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4. Choose the function for the fitting algorithm, that is, Trust-
region or, if not available, then Levenberg–Marquardt
(in MATLAB: opts.Algorithm ¼ ‘Trust-Region’).

5. Provide the starting values for S0 and T2
(*) (in MATLAB, e.g.,

opts.StartPoint ¼ [startVal_S0 startVal_T2]).

6. Define lower and upper limits for the fit parameters. Use for
T2* [0.1 150], for T2 [1 1000], and for S0 the possible range of
SI in the image data (this depends on the system; for 16-bit
integer it may be [1 65536]). In MATLAB, for example,
opts.Lower ¼ [1 0.1]; opts.Upper ¼ [65,536 150].

7. Execute the curve fitting for each pixel data (in MATLAB:
[fitresult, gof] ¼ fit(TE_forFitting, SI_vector,
T2model, opts);).

8. Save the fit result for each variable in parameter maps: mapS0
(xPix, yPix) ¼ fitresult.a; mapT2(xPix,
yPix) ¼ fitresult.b; rsquare(xPix, yPix) ¼ gof.
rsquare.

3.4.6 Visual Display 1. Display the parameter map, which is amatrix with floating point
numbers, as an image (in MATLAB: imagesc(mapT2);).

2. Remove axis labels and ensure that the axes are scaled such that
the aspect ratio of the image is identical to that of the acquired
FOV (For the case of square pixels in MATLAB: axis off;
axis equal;).

3. Select the color map and display a color bar (in MATLAB:
colormap(jet(256)); colorbar;) (see Note 11).

4. Set the display range for the color coding, for example, for T2*
[0 25]; and for T2 [0 80]; (in MATLAB: caxis([0 25]);).
An example is shown in Fig. 9.

3.5 Quantification Quantitative values can be obtained from the parameter maps using
manually drawn ROI for the different morphological regions (cor-
tex, outer medulla, and inner medulla). Because manual ROI draw-
ing can introduce unwanted additional variability or bias, we
recommend the use of semiautomated methods, such as the con-
centric objects technique [9] or the morphology-based ROI place-
ment technique [10]. For further details and step-by-step protocols
for these two techniques please refer to the chapter by Riazy L et al.
“Subsegmentation of the Kidney in Experimental MR Images
Using Morphology-Based Regions-of-Interest or Multiple-Layer
Concentric Objects.”
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3.6 Methods

for Result Validation

3.6.1 Evaluation

of Analysis Errors

and Variability Using

Synthetic Data

A simple approach to validate the data analysis procedure is to
generate synthetic image data and then evaluate how close the
results produced by the analysis are to the known true value. A
series of artificial images could be created (using an in-house soft-
ware program) that mimic a multiecho MR experiment. Each
image could represent a chosen TE for which the signal intensity
in a virtual phantom (could simply be a circle in the center of the
image) has been calculated using the known exponential equation
that describes the T2

(*) relaxation. Alternatively, more sophisticated
simulation approaches as previously described in [3] could be used,
accounting for the timings and characteristics of the used RF pulses
so as to evaluate the effect of using the simpler monoexponential
decay model. Having generated the images, Rician noise is added.
This synthetic data could then be analyzed, evaluating both accu-
racy (how close the resulting T2

(*) is to the true T2
(*)) and precision

(evaluating dispersion over multiple instances with the same level
of SNR).

Fig. 9 T2
(*) in ms and R2

(*) in ms�1 maps of an healthy rat kidney calculated using a custom program
developed in MATLAB (displayed using colormap parula) from data acquired with a preclinical 9.4 T scanner
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3.6.2 Comparison

with Reference Values from

the Literature

The obtained values can be compared with those reported for
healthy animals in the literature. Table 1 provides ranges of T2*
and T2 for different magnetic field strengths based on current
literature.

4 Notes

1. With increasing echo number additional diffusion weighting is
added due to the repeated magnetic field gradients used for
spatial encoding (NB: this effect is much more pronounced in
small animal systems, which use much stronger gradients than
clinical systems). A greater bias is introduced by the superposi-
tion of stimulated echoes in multi-spin-echo imaging, which
leads to significant overestimation of T2. It also demands the
exclusion of the first echo (pure spin echo) from the analysis,
because its magnitude is usually much smaller than that of the
following echoes, which are combinations of spin-echoes and
stimulated echoes. Although these biases depend on the acqui-
sition parameters, they are fixed and reproducible for each
protocol and hence acceptable in studies focusing on relative
differences/changes, where precision is far more important
than accuracy. If needed, more accurate T2 values can be
obtained from multiecho data using sophisticated post-
processing, such as dictionary-matching methodologies [3].

2. Make sure your data is ordered from the lowest to the highest
TE as in Figs. 2 and 3.

3. When establishing the MR technique, define an SNR accep-
tance threshold. The aim is to have at least three (preferably five
or more) number of echoes with an SNR > 5. This threshold
will depend on the expected T2

(*) values, which in turn depend
on parameters like the magnetic field strength, shim quality,
and tissue properties (pathology). Example: for a rat imaged at
9.4 T using a 4-element rat heart array receiver surface RF coil

Table 1
Typical values of T2 and T2* for each specific renal tissue for a healthy rat at 9.4 T [11] and 3 T [12]

Map Inner medulla Outer medulla Cortex

9.4 T [8]

R2 [1 s�1] 11.0–14.6 20.0–23.2 23.0–27.3

R2* [1 s�1] 32.1–47.2 73.9–101.1 64.8–93.6

3.0 T [9]

R2 [1 s�1] 5.5–7.0 9.6–12.5 13.8–16.3

R2* [1 s�1] 12.8–19.8 28.3–30.3 29.5–37.5
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together with a volume resonator for excitation in combination
with interventions leading to strong hypoxia an SNR > 60 was
needed for the image with the lowest TE. Always draw the ROI
over the same region of the kidney, that is, cortex, outer
medulla, or inner medulla (we use the inner medulla, which is
the brightest region of the kidney). If reaching a sufficiently
high SNR is a problem, consider creating ROIs and performing
the T2

(*)-fitting on the average values of these ROIs in order to
boost the SNR (SNR scales with the square root of the number
of pixels). Another option is to modify the acquisition proto-
col, reducing the attained spatial resolution to gain SNR.

4. As a good practice you should always save your ROIs for later
reference.After creating anROIclickonAnalyze>Tools>ROI
Manager> Add. Then rename your ROI to a meaningful name
(using the button “Rename on the ROI Manager).

5. When you create an ROI over a region with no signal make sure
no artifacts are present. Click on Image > Adjust > Brightness
and Contrast and drag the scroll bar “Minimum” to the left.

6. Sum-of-squares reconstruction of multichannel data changes
the distribution of noisy MR magnitude data. Substitute the
factor 0.655 by 0.682 or 0.695 for two channel and four
channel data, respectively [13].

7. The Rician distribution of MR magnitude images introduces a
signal level-dependent positive bias. The relative error intro-
duced by this bias increases with decreasing SNR. For single
receive element coils, an error of 10% is reached at SNR ¼ 2.6.
For two-channel or four-channel coils, the corresponding
threshold is at SNR ¼ 4.2 or 6.4, respectively, assuming sum-
of-squares reconstruction. Under pathophysiological condi-
tions T2

(*) can become significantly shorter and images
acquired at high TEs may have a rather low SNR or may even
reach noise level. This could result in a poor model curve fit and
overestimate the calculated T2

(*). Therefore, data points at
high TEs below a predefined SNR threshold should be
excluded from the data analysis. Data exclusion can be done
either during the acquisition (by not acquiring some echoes) or
performed prior to data analysis. The latter is advantageous
because the SNR cutoff to exclude data from the fitting can
also be adjusted for each pixel individually.

8. When a multiecho sequence is used for T2-mapping, the first
echo must be excluded from the data analysis. The reason is
that the first echo is a pure spin echo, unlike all following
echoes, which are superpositions of spin-echoes and stimulated
echoes. As a result, the first echo has significantly smaller
amplitude than the second echo and fitting the model curve
to all data points would produce a poor curve fit and an
inaccurate T2 value [10].
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9. MLE option refers to “Maximum-likelihood estimator” that
takes into account the Rician noise. The noise level is measured
as part of the scan. This approach should be robust against
noise floor estimation bias and therefore there is no need to
exclude later echoes from the analysis [5, 6].

10. An approach to increase the speed of the curve fitting is using a
fast mono exponential fit [14]. The MATLAB implementation
of the following fit can be downloaded from https://github.
com/JoaoPeriquito/T2-s-Mapping under the name fastExpo-
Fit.m. The result of a simulation comparing the recommended
fast mono exponential fit and the trust-region can be found at
the same location under the name fastExpoFit_Simulation.png.

11. Pseudocolor representations can be extremely useful for ana-
lyzing T2

(*)-maps, since they generally enhance the perception
of differences within the value range of the parameter. But one
needs to be careful when choosing a color map. Parameter
maps displayed as images in pseudocolor can potentially be
misleading. Small differences in the underlying values may be
artificially emphasised by a change in color hue, or a significant
parameter difference that can easily be seen in a gray-scale
image may be flattened or hidden if there is little change of
hue or brightness over a certain range of the color-scale. It is
recommended to always use the same color map and scale to
improve comparability.
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